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Introduction

1. Introduction

This user manual provides an overview of the functions of the "scanCONTROL Result Monitor" software,
referred to in short as "Result Monitor". Result Monitor offers you the opportunity to perform typical
measuring tasks using the scanCONTROL measuring system, monitor measuring and the measuring
progress and record the measured values. A parallel transfer of the measured values to the control is
possible and recommended. The scanCONTROL measuring system is a laser line sensor which is
designed for applications in the industrial environment.

This product is distinguished by varied options for use and high measuring accuracy. Result Monitor
provides you with ways to solve different applications combined with maximum precision.

1.1 Using this Manual

This user manual contains general information on the installation and use of Result Monitor and on the
use of the scanCONTROL measuring system. As a user of the software, it is important that you read
Chapter 2 "Installation and Preparation for Measuring Operation". Chapter 3 "Working with Result Monitor"
explains how to use the functions offered by the software. Chapter 4 "Working with the scanCONTROL
Measuring System" describes how to work with the scanCONTROL measuring system.

Note: Please refer to the contact address printed on the inside cover for any issues relating to queries
and support or any other technical information.

1.2  Overview of the Complete System

Result Monitor receives profile data and measurements in a simple way from up to four scanCONTROL
measuring systems and displays these graphically. All data are transferred via Ethernet, and can be
stored with the software if needed.

The scanCONTROL measuring system records two-dimensional profile data, sequentially processes the
data in function modules and analyzes these, and determines user-defined measured values and
evaluates these. The measured values are output at various ports (see Fig. 1.1), e.g. to a connected
controller. Result Monitor is used to visualize and log the preconfigured measurements parallel, but does
not access these interfaces.

scanCONTROL 25XX/26XX/29XX/30XX

RS422 (ASCII format, binary) half-duplex

RS422 (Modbus RTU protocol) half-duplex

Ethernet (UDP, ASCII format, binary) yes

Ethernet (Modbus TCP protocol) yes

Analog out x4 "

Digital out x8 "

ProfiNET yes ™

Ethernet/IP yes ™

EtherCAT yes ™

* optional, 2D/3D Output Unit is required
** optional, 2D/3D Gateway is required

Fig. 1.1: Measured values output ports

Note: The transfer and display of measured values is only possible with scanCONTROL measuring
systems of the SMART product type.

Note: The following software packages can be used to parameterize the scanCONTROL measuring
system and configure the measurement tasks:

- scanCONTROL Application Tools

- scanCONTROL Configuration Tools (version 6.3 and above)
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Function

Visualization of profiles and measurement results
Logging measurement results

Statistical analysis of measurement results

Saving profile sequences

Activating stored parameters (user modes)

Saving and restoring parameters and layout settings
Select language

Fig. 1.2: Functional scope of scanCONTROL Result Monitor
1.3 Definition of Basic Terms

- Profile/Profile data: A profile consists of individual measuring points. Each of these points is
defined by its X and Z coordinate.

- X coordinate: The horizontal coordinate of a point.

- Z coordinate: The vertical coordinate of a point.

- Profile sequence: A chronologically consecutive series of profiles.

- Scan rate: Refers to the number of measuring operations performed per second.

- Measuring operation: Refers to the operation in which a profile is recorded by scanCONTROL
and all measured values are determined.
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Installation and Preparation for Measuring Operation

2. Installation and Preparation for Measuring Operation
2.1 Installation Requirements
The following minimum system specifications are necessary for the operation of Result Monitor:

- Windows 8 or 8.1 (64 bit), Windows 10 (64 bit), Windows 11 (64 bit)
- 1 GHz processor (64 bit) or higher
- 1GBRAM

Note: Due to a high data rate, we recommend using a Gigabit Ethernet connection and a high-quality
Ethernet PC plug-in card, for example IntelPro/1000 PT.

To be able to use Result Monitor, the following steps must be followed:

E3 1. Install the Ethernet port hardware, if not already installed.
E3 2. Install Result Monitor (see Chapter 2.2).
E3 3. Connect the scanCONTROL measuring system to the PC via Ethernet.

[Installation package]:\Documentation Contains the manual and installation instructions

[Installation package]:\License Contains licensing information for Result Monitor

[Installation package]:\Program\scanCONTROL Contains scanCONTROL Result Monitor 1.1
Result Monitor 1.1\x64

[Installation package]:\Support\Ethernet Contains a software tool for configuration of the IP
addresses of scanCONTROL measuring systems with
an Ethernet interface

[Installation package]:\Support\FImageFilter\x64 | Contains filter files for integrating DirectX

[Installation package]:\Support\VCRedist2008 Contains the "Microsoft Visual C++ 2008"
Redistributable Package

[Installation package]:\Support\VCRedist2017 Contains the "Microsoft Visual C++ 2017"
Redistributable Package

Fig. 2.1: Contents of the installation package
2.2  Software Installation

After extracting the installation files to a temporary folder, an installation window appears which offers you
a number of options. Alternatively you can start the window with the [Temporary folder]:\setup.exe file.

E3 Click on the "Install" button to start installing the software.

Now the installation wizard installs the software and necessary components.

Note: Activate the "Configure Windows firewall" option to enable data transfer between measuring system
and the Software if there is an active firewall.

Note: If a third-party firewall is installed on your operating system, you must include Result Monitor in the
firewall exception list to enable communication between the measuring system and the software.

2.3 Connecting scanCONTROL to the PC
In order to connect scanCONTROL via Ethernet to the PC, proceed as follows:

E32 Complete the entire installation of scanCONTROL Result Monitor. This process is described in
Chapter 2.2.

E3 Connect scanCONTROL via the Ethernet interface to the PC and switch on the power supply.

E3 Please wait until the scanCONTROL measuring system is recognized by the PC. This may take a
few seconds.

The system is now ready to operate the scanCONTROL measuring system with scanCONTROL Result
Monitor.

Note: scanCONTROL must be connected directly to the PC. Do not use hubs and only suitable switches.
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Installation and Preparation for Measuring Operation

Note: If your network adapter supports the "VLAN" option, this option must be deactivated in order to
operate the scanCONTROL measuring system.

Note: To be able to operate the scanCONTROL measuring system, the PC and the measuring system
must be located in the same subnet. If necessary, use the "Ethernet Configurator" dialog (see
Chapter 3.16) to adjust the measuring system’s network settings.
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3. Working with Result Monitor
3.1 Starting the Software

Once software installation has been completed, start Result Monitor. To do this, use the program shortcut
on your desktop or select "scanCONTROL Result Monitor" in the Start menu.

After you start the program, the software automatically connects to scanCONTROL and visualizes current
profile data and related measurement results. An extensive description of the control and display
elements is provided in Chapter 3.3.

Note: The transfer of measured values is only possible if this has been configured in advance and the
appending to profile data has been activated (see Chapter 1.2).

3.2 Log into the System

The system is protected against unauthorized changes with a password (see below). After starting the
program, no user is logged into the system. Use the "User - Log on" or "User - Log off" menu item to
log into or out of the software.

Name Password | Rights
Reduced functionality
scanCon scancon Access to the entire system

3.3 The Control and Display Elements

After you start the program, the software automatically connects to scanCONTROL and visualizes current
profile data and associated measurement results (see Fig. 3.1).
7
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Fig. 3.1: The Control and Display Elements
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Working with Result Monitor

The structure of the user interface is divided into the following sections:

1
2

Menu bar: Calls up various settings and functions (see Chapter 3.6).

"General" toolbar: Using this toolbar, you can load parameters (see Chapter 3.10.2), save
parameters (see Chapter 3.10.1) and reset parameters to default settings (see Chapter 3.12).

Sensor selection: Select a scanCONTROL measuring system to display its profiles and results (see
Chapter 3.4).

Sensor status: This section displays current information from the scanCONTROL measuring
system (see Chapter 3.4 and 5.1).

Profile display: This display visualizes the currently measured profile and, if applicable, associated
measuring points. You can scale the profile display by using the "Display" toolbar (see Chapter 3.8).

"Display" toolbar: Use this toolbar to scale the profile display and activate various options for
mouse interaction (see Chapter 3.8).

Results display: This display lists all available measured values. The measured values are
continuously updated. The names of the measured values can be edited.

Measured values progression: This display visualizes the measured values selected for analysis
over time.

Analysis of measured values: This section lets you select the measured values for measured
values progression and statistical analysis (see Chapter 3.16).

10 "Display" toolbar: Use this toolbar to scale the display of the measured values progression and

activate various options for mouse interaction (see Chapter 3.8).

11 "Measurement" toolbar: Use this toolbar to set the various limits for analysis (see Chapter 3.9).

12 Data transfer: Set the buffer size and control the measured values progression (see Chapter 3.17).

13 Status bar: Status and error messages are displayed in the status bar (see Chapter 5.1).

14 System info: This section displays the user who is currently logged in and the system time.

You can change the size of individual sections or hide the sections.

3.4

Selecting the scanCONTROL Measuring System

When the software is started, Result Monitor automatically reestablishes the connection with the
scanCONTROL measuring system that was connected last. You can manage the sensor connections in
the "Sensor selection" input field (see Fig. 3.2).

Sensor 1

Connected &

SN: 519110059 1P: 192.168.1.1
SN: 519060095 IP: 169.254.182.179

\

v

2 —[ Disconnect ][ Find...

mo. of profiles [1/s]:
Profile number:
Lost profiles:

\Active: scanCONTROL 3060-25 v35B06

Type: scanCONTROL 3060-25 v55B06

30.0)

610978 |

0

)

4

Fig. 3.2: "Sensor selection" input field
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Parameters in the "Sensor selection" input field:

1
2

3

List of sensors: This list contains all scanCONTROL measuring systems connected to the PC.

Connect/Disconnect: Depending on the selection in the sensor list, this button provides the
following functions:

Find..

Disconnect: If the currently active measuring system has been selected in the selection
list, you can use the "Disconnect" button to terminate the connection to the measuring
system.

Connect: If a measuring system that is currently not connected to Result Monitor has been
selected in the selection list, you can use the "Connect" button to establish a connection to
the selected measuring system. The connection to the previously connected measuring
system is terminated in the process.

.2 Click this button to identify all measuring systems that are connected via Ethernet to the

PC. This function is performed automatically when you start the software. After the process has
been completed, the list of sensors is updated and you can switch between the measuring
systems found.

If the sensor is connected, current information of the scanCONTROL measuring system is
displayed below the "Sensor selection" input field. You may configure the display in the basic
settings (see Chapter 3.5).

No. of profiles [1/s]: This value shows the effective scan rate that is used to analyze
sensor data. There may be a discrepancy between the setpoint value and the actual value
for the scan rate if the number of scans is set too high for the processing power of the PC.
Profile number: The current profile number.

Lost profiles: The number of lost profiles since resetting the counter (connecting to the
measuring system or using the "Reset lost profiles” button in the "Settings” dialog, see
Chapter 3.5).

Type: The currently used type of measurement system and the associated firmware
version are displayed.

Status line: Status and error messages are displayed on the status line (see Chapter 5.1).
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3.5 Adjusting Basic Settings

Select the "Options > Settings" menu item to specify basic settings for the software. The "Settings" dialog
is displayed (see Fig. 3.3).

T Settings ? X

('scanCONTROL
Display update rate [1/s]:

Size of ring buffer: 100

e R b
-~
-Results

[] eold
NG

/P?ofile displays \

[] show center of measuring range

[] show measuring range

I:‘ Show sensor position

[] show recently used parameters
[ braw lines

\PDH"It sZe: 2 -

‘Protocol SEEEII‘IgS
[] pelete files older than days 4

(Warnings
[] show warning for high network load ——-175

7Scanner status ™
[] Profile counter

[] Lost profiles Reset lost profiles —— 6

[ Type
N

Fig. 3.3: "Settings" dialog

Parameters in the "Settings" dialog:
1

Display update rate [1/s]: Specify the speed at which the display is updated.
- Size of ring buffer: Specify the size of the ring buffer that can be saved to a file by using the
"Save Ring Buffer" menu (see Chapter 3.15).

2 - Font size: Enter the font size for the numerical display of the result values here.
- Bold: Enter the font format for the numerical display of the result values here.

3 - Show center of measuring range: Shows the center of measuring range in the profile display.
- Show measuring range: Shows the measuring range in the profile display.
- Show sensor position: Shows the sensor position in the profile display.
- Show recently used parameters: Shows the recently used parameters in the profile display.
- Draw lines: Draws a straight line between adjacent points in the profile display.
- Point size: Defines the point size in the profile display.

4 - Delete files older than [days]: If this option is active, log files that are older than the value set
are automatically deleted.

- Show warning for high network load: Displays a warning when high network load occurs.

- Profile counter: Shows the current profile number (0 - 16777215).

- Lost profiles: Shows the number of lost profiles since connecting to the measuring system.

- Reset lost profiles: Press this button in order to reset the lost profiles counter.

- Type: Shows the currently used type of measurement system and the associated firmware
version.
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3.6 Menu Bar

A summary of the menu bar functions is provided below.

1 2 3 4 5

Fig. 3.4: Menu bar
1 - File:

File Parameters Options User ?
Activate protocol results  *
Save ring buffer 4

Exit
Fig. 3.5: "File" menu

» Activate protocol results: Activates saving of measured values of the respective sensor
to an ASCII file for analytical purposes (see Chapter 3.14).

= Save ring buffer: Saves profiles from the ring buffer of the respective sensor to a file
(see Chapter 3.15).

= Exit: Ends Result Monitor.

2 - Parameters:

File | Parameters Options User 7

Load parameters Ctrl+0
Save parameters Ctrl+S

Activate scanCONTROL parameters 4
Recent parameters 4

Load layout settings
Save layout settings

Reset parameters Ctrl+R
Fig. 3.6: "Parameters" menu

» Load parameters: Loads parameters of Result Monitor from a file (see Chapter 3.10.2).
= Save parameters: Saves the parameters of Result Monitor to a file (see Chapter 3.10.1).
= Activate scanCONTROL parameters: Activates parameters that have been saved on
the respective sensor scanCONTROL measuring system (see Chapter 3.13).
= Recent parameters: Loads previously saved or loaded parameters.
» Load layout settings: Loads layout settings of Result Monitor from a file (see
Chapter 3.11.2).
= Save layout settings: Saves the layout settings of Result Monitor to a file (see
Chapter 3.11.1).
» Reset parameters: Resets parameters and layout settings to default settings (see
Chapter 3.12).
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3 - Options:
File Parameters Options User ?
Settings Ctrl+F7
Ethernet Configurator Ctrl+F8
E&  Language: English [EN] »

Fig. 3.7: "Options" menu

» Settings: Activates a dialog where you can specify basic settings (see Chapter 3.5).
= Ethernet Configurator: Opens a dialog where you can modify the network settings (IP
address, etc.) of scanCONTROL measuring systems (see Chapter 3.18).
» Language: Select the display language of Result Monitor:
= English [EN]: English.
= Deutsch [DE]: German.

4 - User:
File Parameters Options User 7
Log off
Log on

Fig. 3.8: "User" menu

» Log off: Logs out the current user (see Chapter 3.2).
* Log on: Opens a dialog where you can log in with name and password (see
Chapter 3.2).

File Parameters Options User 7?7
About scanCONTROL Result Monitor

Online help F1
Manual scanCONTROL Result Monitor

Shortcuts
Documentation

Fig. 3.9: "?" menu

= About Result Monitor: Opens an information window about Result Monitor.

= Online help: Opens the documentation for the current view.

= Manual scanCONTROL Result Monitor: Opens the Result Monitor operating
instructions.

= Shortcuts: Opens an overview of the available shortcut keys (see Chapter 5.3).

= Documentation: Opens an overview where you can call up various help screens and
documentation (installation guide, user manual, data sheet, operating instructions, ...).

3.7 '"General" Toolbar
A summary of the functions of the "General" toolbar is provided below.
Fig. 3.10: "General" Toolbar

Loads measuring program parameters from a file (see Chapter 3.10.2).

Saves the parameters of all active measuring programs to a file (see Chapter 3.10.1).

5 D

Resets parameters to default settings (see Chapter 3.12).

£
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3.8 "Display" Toolbar

A summary of the functions of the "Display" toolbar is provided below.
23| (o8] 1) [/ () [#) [~

Fig. 3.11: "Display" toolbar

¢1| Click this button to reset the profile/result monitor display. This causes the settings of the profile
display to be reset in such a way that the entire measuring/results range is displayed.

## You activate or deactivate automatic scaling of the profile display by clicking this button. If
automatic scaling is activated, the profile display automatically adjusts to the smallest and
largest profile point measured by scanCONTROL.

11, Click this button to activate or deactivate the "Keep aspect ratio" option. If this option is
activated, the profile display is scaled in such a way that the real aspect ratio of the displayed
profile is retained. If this option is deactivated, the scaling is adapted separately to the actual
values for the X and Y axes.

X, You activate or deactivate the "Zoom" mode by clicking this button. In this mode, you can zoom
into the profile/result monitor display and thereby directly set the scaling of the profile/result
monitor display with your mouse.

Az

You activate or deactivate the "Move" mode by pressing this button. You can move the

e
profile/result monitor display if the "Move" mode is activated.
| Click this button to activate or deactivate the "Point information" mode.
+§  Activates or deactivates automatic scaling of the vertical display area. If automatic scaling is

activated, the vertical display area automatically adjusts to the smallest and largest values of the
result values that you chose for analysis.

3.9 "Measurement" Toolbar

Use this toolbar to set the various limits for evaluation (see Fig. 3.12).

el |6l ] |2

Fig. 3.12: "Measurement" toolbar

Activates or deactivates "Set evaluation lines" mode. Use this setting to define the range for the
statistical evaluation of measured values. By default, all measured values are evaluated.

*i Removes the evaluation range. All the recorded values are used for statistical evaluation.

==  Activates or deactivates "Set marker lines" mode. Using this setting, you define two marker lines
that are used to acquire undershoots or overshoots (peaks).

o Removes the marker lines.

3.10 Saving and Loading Parameters

Result Monitor allows you to save and load parameter sets. For example, you can save parameters for
different measuring settings and therefore configure the measuring system for different measuring tasks.

Once you have saved all the parameters for measurement settings you can load them again later on. You
can save the parameters for as many measuring tasks as you like.
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3.10.1 Saving Parameters

To save parameters, either select the "Parameters - Save parameters" menu item or click the
corresponding button (see Fig. 3.13) on the "General" toolbar.

E|

Fig. 3.13: "Save parameters" button

A standard Windows dialog is displayed for selection of the path and file name for saving the parameters.
The file name has the extension ".sr1". The parameters are saved in the selected file after confirmation of
the dialog.

3.10.2 Loading Parameters

To load previously saved parameters, either select the "Parameters > Load parameters" menu item or
click the corresponding button (see Fig. 3.14) on the "General" toolbar.

e
=]

Fig. 3.14: "Load parameters" button

A standard Windows dialog is displayed for selection of the path and file name from which the
parameters should be loaded. The file name has the extension ".sr1". The parameters are loaded after
confirmation of the dialog.

Note: Use the "Parameters > Recent parameters" menu item to load previously saved or loaded
parameters.

3.11 Saving and Loading of Layout Settings

Result Monitor allows you to save and load layout settings sets. In this way you can configure the layout
of the system according to your own needs.

Once you have saved the layout settings you can load them again later on. You can save the layout
settings for as many measuring tasks as you like.

3.11.1 Saving Layout Settings

To save layout settings, select the "Parameters > Save layout settings" menu item.

A standard Windows dialog is displayed for selection of the path and file name for saving the layout
settings. The file name has the extension ".xml". The layout settings are saved in the selected file after
confirmation of the dialog.

3.11.2 Loading Layout Settings

To load previously saved layout settings, select the "Parameters - Load layout settings " menu item.
A standard Windows dialog is displayed for selection of the path and file name from which the layout

settings should be loaded. The file name has the extension ".xml". The layout settings are loaded after
confirmation of the dialog.
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3.12 Resetting Parameters to Default Settings

To reset parameters to their default settings, either select the "Parameters > Reset parameters" menu
item or click the corresponding button (see Fig. 3.15) on the "General" toolbar.

Fig. 3.15: "Reset parameters" button

A dialog is displayed (see Fig. 3.16) where you can select which parameters should be reset.

T Reset parameters ? X

-Parameters
Farameters

Layout settings

select all

Fig. 3.16: "Reset parameters" dialog
The following parameters can be reset:

- Parameters: Parameters of Result Monitor (see Chapters 3.5, 3.16 and 3.17).
- Layout settings: Layout settings (see Chapter 3.5).
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3.13 Activating Parameters on scanCONTROL

Result Monitor allows you to activate various predefined parameter sets (user modes) on the currently
connected sensors.

To activate a specific parameter set on the connected scanCONTROL measuring system, select the
"Parameters > Activate scanCONTROL parameters - Activate scanCONTROL parameters sensor X"
menu item.

The dialog "Activate user mode sensor X" is displayed. In this dialog, select the parameter set (user
mode) to be activated. After you have confirmed the dialog with OK, the selected parameters are
activated on the scanCONTROL measuring system.

T Activate user mode sensor 1 ? X

- Activate scanCONTROL parameters

User mode: 1 (current) ~

Fig. 3.17: "Activate user mode sensor X" dialog
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3.14 Logging Results

Result Monitor allows you to log measured values to an ASCII file. To activate a logging of measured
values, select the "File > Activate protocol results > Activate protocol results sensor X" menu item (see
Fig. 3.18):

% Activate protocol results sensor 1 ? X

- Protocol results
Active

File: |Jsers\11DDD236\Documents\protuco\ Sensor ]..tx't|

Fig. 3.18: "Activate protocol results sensor X" dialog

- Active: Activate or deactivate logging of results.
- File: Specify the path and file name of the log file.

Note: A time stamp in "YYYY-MM-DD" format is appended to the file name. Where YYYY is year, MM
month, DD day, HH hour, MM minute, SS second.

3.15 Saving Ring Buffer
The ring buffer is continuously filled with profile data from the measuring system.

To save a profile sequence from the ring buffer, select the "File > Save ring buffer > Save ring buffer
sensor X" menu item.

A standard Windows dialog is displayed for selection of the path and file name for saving the profile
sequence. The ring buffer is not filled during the file selection process. Once the selection has been
confirmed, the profiles from the ring buffer are saved in the selected file, and the filling of the ring buffer is
continued.

Note: A “%” character in the file name is replaced by a time stamp in "YYY-MM-DD_ HH-MM-SS" format.
Where YYYY is year, MM month, DD day, HH hour, MM minute, SS second.
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3.16 Settings for Analysis of Measured Values

Proceed as follows to analyze the development of a measured value over time:

=3 Click on the "Signal X" button.

The following dialog is displayed:

= Result monitor signal 1 settin... ? X

Signal 1: X coordinate 1 e
OK/noK
Evaluation: Current value =

Tolerance +-: 0

Fig. 3.19: "Result Monitor signal X settings" dialog

The following settings are available:

Signal X: Select the measured value to be analyzed.
OK/nOK: If the OK/nOK evaluation is activated for the measured value, it can be selected for
analysis.
Evaluation: Select the statistical characteristic that is to be determined:
= Current value: The currently measured value.
= Minimum value: The smallest measured value.
= Maximum value: The largest measured value.
= Mean value: The mean value.
= No. of min. peaks: Number of times measurements fell below the bottom marker line.
= No. of max. peaks: Number of times measurements exceeded the top marker line.
= No. of peaks: Number of times measurements fell below the bottom or exceeded the top
marker line.
= Standard deviation: The standard deviation of the measured values.
= Capability gauge measurement (CGM): Capability index, calculated as follows:
0.2*abs(2*tolerance)/(6*standard deviation).

Note: For 50 measured values, the above specifications are sufficient for checking
measuring equipment capability ("Statistical Procedures for Machine and Process
Quialification"; 3rd edition; Edgar Dietrich, Alfred Schulze; Carl Hanser Verlag Munich,
Vienna) if the following condition is fulfilled: CGM >= 1.33 (process 1).

Tolerance +/-: The tolerance value for calculating the capability index.

3.17 Control of Analysis of Measured Values

Set the buffer size and control the measured values progression (see Fig. 3.20).

(=

2
2
=

In the "Buffer size" section, enter the buffer size. The buffer size determines the maximum number
of measured values that are used for statistical evaluation. If the maximum number of measured
values has been reached, the system deletes the oldest values from the buffer and inserts the
current values into the buffer.

Click the "Start data transfer" button ®| to start or resume the measured values progression.

Click the "Stop data transfer" button (11 to interrupt the measured values progression.

Click the "Clear buffer" button X to delete the contents of the buffer.

Data transfer [~]

® X Buffer size: m

Fig. 3.20: "Data transfer" dialog
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3.18 Adjusting scanCONTROL Network Settings (Ethernet Configurator)

Applications Tools lets you adjust the network settings (IP address, etc.) of the measuring system. Use
the "Options - Ethernet Configurator" menu item for this purpose. The "Ethernet Configurator" dialog will
open.

Note: To be able to operate a scanCONTROL measuring system via Ethernet with Result Monitor, the
measuring system and PC must be located in the same subnet. Adjust any relevant network settings for
the measuring system in the "Ethernet Configurator" dialog.

; Ethernet Configurator ? X
- Device list
( Type SN P address
gapCONTROL 2711-25 77007 w30BO7 12032209AC 109060020 10.6.36.157
scanCONTROL 3060-25 /BL v46B01 19021311AC 219010002 169.254.86.178
\| < >
[ o | I |
- P€vice info /ﬁesired configuration %
Device: scanCONTROL 3060-25 /BL v46B01 19021311AA P address: |:|
MAC address: 00-0c-12-01-79-16 - i I:l 4
|| 1 address: 169.254.86.178 DI
Subnet mask: 255.255.0.0 L] static 1P
Default gateway: 0.0.0.0 [ oHer
Static IP: not activated \ Link local address /
RUELE activated Suggest a configuration 5
Link local address: activated
Qconﬁguration: 0.K. / Apply to selected device 6

‘ Done

Fig. 3.21: "Ethernet Configurator" dialog

Display elements and parameters in the "Ethernet Configurator" dialog:

1

Device list: This display lists all available measuring systems. Use the "Scan" button to update this
list. Select the desired measuring system.

Scan: Click this button to scan for scanCONTROL measuring systems in all subnets connected to
the PC. The scan progress is displayed. When the scanning is complete, any found measuring
systems are displayed in the list.

Device info: The current settings of the selected scanCONTROL measuring system are displayed:

Device: Device name.

SN: Serial number.

MAC address: Physical address.

IP address: IP address.

Subnet mask: Subnet mask.

Default gateway: Default gateway.

Static IP: "Static IP address" option active.

DHCP: "DHCP" option active.

Link local address: "Link local address" option active.

IP configuration: Indicates whether the network configuration is valid. If the network
configuration is not valid, the measuring system cannot be operated using Result Monitor.

Page 21



Working with Result Monitor

4 Desired configuration: Use these input fields to enter the desired network configuration for the
selected scanCONTROL measuring system:

- IP address: IP address.

- Subnet mask: Subnet mask.

- Default gateway: Default gateway.

- Static IP address: "Static IP address" option. If this option is active, dynamic address
assignment is inactive. The IP address entered is used as IP address. This parameter takes
priority over the "DHCP" and "Link local address" options.

- DHCP: "DHCP" option. If this option is active, an IP address is assigned dynamically through a
DHCP server. This parameter takes priority over the "Link local address" option.

- Link local address: "Link local address" option. If this option is active, the IP address is
assigned dynamically in the local subnet 169.254.x.x. This option is always enabled.

5 Suggest a configuration: Click this button to have a suitable configuration for the selected
scanCONTROL measuring system determined automatically. After the process has been
completed, the system automatically enters the corresponding values in the input fields of the
"Desired configuration" section.

6 Apply to selected device: Use this button to apply the network configuration specified in the
"Desired configuration" section to the selected scanCONTROL measuring system.

Proceed as follows to manually enter the network configuration parameters for a scanCONTROL
measuring system:

E2 When the "Ethernet Configurator" dialog is opened, the system automatically searches for available
measuring systems. If the measuring system is not yet connected to your subnet, establish a
connection, and click the "Scan" button.

When scanning is complete, the measuring system is displayed in the device list.

E2 Select the required measuring system from the device list.

E3 Specify the desired network settings in the input fields of the "Desired configuration" section.

E3 Click the "Apply to selected device" button to apply the settings to the selected measuring system.
E3 Confirm the "Ethernet Configurator" dialog with OK.

Proceed as follows to automatically specify network configuration parameters for a scanCONTROL
measuring system:

E2 When the "Ethernet Configurator" dialog is opened, the system automatically searches for available
measuring systems. If the measuring system is not yet connected to your subnet, establish a
connection, and click the "Scan" button.

When scanning is complete, the measuring system is displayed in the device list.

E2 Select the required measuring system from the device list.

E2 Click the "Suggest a configuration" button to have a suitable network configuration for the selected
scanCONTROL measuring system determined automatically.

After the process has been completed, the system automatically enters the corresponding values in the

input fields of the "Desired configuration" section.

E3 Click the "Apply to selected device" button to apply the settings to the selected measuring system.
E3 Confirm the "Ethernet Configurator" dialog with OK.

3.19 Exiting the Software

Select the menu item "File - Exit" or press the standard Windows button in the title bar of the
program window in order to exit scanCONTROL Result Monitor.
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4. Working with the scanCONTROL Measuring System

The scanCONTROL measuring system records two-dimensional profile data, analyzes the profile data,
determines measured values and evaluates these. The measured values are output at various ports.
Result Monitor visualizes the measurement results of the measuring system, but is not definitively
required to operate the measuring system. The scanCONTROL measuring system operates as an
independent unit and performs measurements. Handling the measuring system and the interfaces is
described in the following.

Note: Always exit the software first and then disconnect the connection between the measuring system
and the PC.

4.1 Operating Modes

Depending on how the scanCONTROL measuring system was set up, two different operating modes are
possible when measurements are performed.

4.1.1 Continuous Measurement

scanCONTROL measures continuously at the specified scan rate.

41.2 Triggered Measurement

Depending on the type of sensor, the following interfaces are available for triggering scanCONTROL:
scanCONTROL 25XX/26XX/29XX/30XX

RS422 half-duplex
Digital in yes

Every trigger signal triggers a measurement operation. For technical details, please refer to the
instruction manual of the measuring system used.

RS422 interface

scanCONTROL 25XX/26XX/29XX scanCONTROL 30XX

Pin | Assignment| Cable color PC2600-x/ Pin | Assignment| Cable color PC2600-x/
PC2900-x/PCR3000-x PC2900-x/PCR3000-x

4 GND-In1 green 10 | GND-RS422 | violet

11 | RS422 - gray-pink 11 | RS422 - gray-pink

12 | RS422 + red-blue 12 | RS422 + red-blue

Digital input

scanCONTROL 25XX/26XX/29XX scanCONTROL 30XX

Pin | Assignment| Cable color PC2600-x/ Pin | Assignment | Cable color PC2600-x/
PC2900-x/PCR3000-x PC2900-x/PCR3000-x

4 GND-In1 green 7 GND-In black

6 In1 yellow 4 In1 green

Circular connector

Fig. 3.22: scanCONTROL 25XX/26XX/29XX/30XX trigger input (RS422 interface half-duplex and digital
input, view on solder side of plug)

4.2  Outputting Measured Values

4.2.1 Pin Assignment of the Analog Outputs

For detailed information on pin assignment and use of analog outputs, please refer to the scanCONTROL
operating instructions and the manuals for the bus and output terminals used.
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4.2.2 Pin Assignment of the Digital Outputs

For detailed information on pin assignment and use of digital outputs, please refer to the scanCONTROL
operating instructions and the manuals for the bus and output terminals used.

4.2.3 Pin Assignment of Serial Port

The scanCONTROL measuring system provides a serial port that can be used to output selected
measured values. The RS422 port exists as half duplex.

scanCONTROL 25XX/26XX/29XX scanCONTROL 30XX

Pin | Assignment| Cable color PC2600-x/ Pin | Assignment | Cable color PC2600-x/
PC2900-x/PCR3000-x PC2900-x/PCR3000-x

4 GND-In1 green 10 | GND-RS422 | violet

11 RS422 - gray-pink 11 | RS422 - gray-pink

12 | RS422 + red-blue 12 | RS422 + red-blue

Circular connector

Fig. 3.23: scanCONTROL 25XX/26XX/29XX/30XX RS422 interface half duplex (view on solder side of plug)

4.2.4 Converting the Measured Values to Real Coordinates

The scanCONTROL measuring system calculates measured values in sensor coordinates. Please use the
following table to convert the measured values to real coordinates:

Measured value Conversion

X coordinates [mm] y = (x - 32768) * a;

Z coordinates [mm] y = (x-32768) * a + b;

Angle [°] y = 0.01 * x;

Offset [mm] y = (x-32768) * a + b;

Sigma [mm] y=Xx*a;

Height/width/distance/radius [mm] | y = x * g;

Area [mm?2] y =X*a?

Temperature [°C] y =0.1 *x-273.10
Whereby:

- x: Measured values in sensor coordinates.

- y: Converted measured values in millimeters or degrees.
- a: Scaling factor.

b: Offset (center of measuring range).

The constants a and b have the following values depending on the type of sensor:

Type of sensor a b Type of sensor a b
scanCONTROL 25X0-25 0.001 65 scanCONTROL 29X0-10 0.0005 | 55
scanCONTROL 25X0-50 0.002 95 scanCONTROL 29X0-25 0.001 65
scanCONTROL 25X0-100 0.005 250 scanCONTROL 29X0-50 0.002 95
scanCONTROL 26X0-25 0.001 65 scanCONTROL 29X0-100 0.005 250
scanCONTROL 26X0-50 0.002 | 95 scanCONTROL 30XX-25 0.001 85
scanCONTROL 26X0-100 0.005 | 250 scanCONTROL 30XX-50 0.002 125
scanCONTROL 27X0-25 0.001 100 scanCONTROL 30XX-100 0.005 270
scanCONTROL 27X0-50 0.002 | 210 scanCONTROL 30XX-200 0.007 | 310
scanCONTROL 27X0-100 0.005 | 450 scanCONTROL 30XX-430 0.010 | 520
scanCONTROL 30XX-600 0.015 850

To invert the profile points, the following formula is used:

Z[MmM]invertes = 2*b - @ - z[mm)]
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4.3  Activating "User Modes"

The parameter sets (user modes) saved in the scanCONTROL measuring system can be activated using
various interfaces. For further details, please refer to the instruction manual of the measuring system
used.

In addition, scanCONTROL lets you activate user modes via the serial port or via Ethernet. Available
interfaces for activating user modes:

scanCONTROL 25XX/26XX/29XX/30XX
RS422 (ASCII) half-duplex
RS422 (Modbus RTU) half-duplex
Ethernet (Modbus TCP) yes
Ethernet (TCP) yes
Digital in yes

Note: For detailed information on activating user modes, please refer to the "Quick Reference" document
(see Chapter 3.6, Section 5 "Documentation").

4.3.1 Activating User Modes Using the Serial Port (ASCII)
Configuration of the serial port:

- Data bits: 8

- Parity: none

- Stop bits: 2

- Flow control: none

- Baud rate: Preset on scanCONTROL.

Please use the following commands:
- Activate user mode: Use the following command to activate a user mode:
setg 0xf0£f00624 0x[User mode no.]0000000
Example: Use the following command to activate user mode 2:
setg 0xf0£00624 0x20000000

- Determine the current user mode: Use the following command to retrieve the number of the user
mode that is currently activated:

getqg 0xf0£00624
scanCONTROL replies as follows:
#g 0xf0£f00624 0x[User mode no.]0000000

Note: Specify [User mode no.] in hexadecimal format.

4.3.2 Activating User Modes Using Modbus

Use the serial interface (Modbus RTU) or the Ethernet interface (Modbus TCP) to activate user modes
using Modbus. The commands may be implemented as single write commands or as multiple write
commands.

Note: If individual registers are written, register 32 always must be written last.
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Please use the following commands:

- Activate user mode: Write the following holding registers to activate a user mode:

Register Value Description

37 0x[User mode 0x0000 for user mode 0, 0x1000 for user mode 1, ..., 0xfO00
no.]000 for user mode 15

36 0x0000 -

35 0xfOf0 scanCONTROL address for user modes (upper 16 bit)

34 0x0624 scanCONTROL address for user modes (lower 16 bit)

33 0x0000 -

32 0x0002 Corresponds to "setq"

- Determine the current user mode: Write the following holding registers to retrieve the number of the
user mode that is currently activated:

Register Value Description

35 0xfof0 scanCONTROL address for user modes (upper 16 bit)
34 0x0624 scanCONTROL address for user modes (lower 16 bit)
33 0x0000 -

32 0x0003 Corresponds to "getq"

The current user mode can now be read from register 37
(format: Ox[User mode no.]000, e.g., 0x2000 for user mode 2).

4.3.3 Activating User Modes via Ethernet (TCP)
Use a TCP client (port 502) to activate user modes via Ethernet (TCP).

Please use the following command:

Activate user mode: Use the following binary byte sequence to activate a user mode:

Value Description

0xf4 Transaction identifier (arbitrary, you may use any number instead of
0x06 0xf406)

0x00 . -

0x00 Protocol identifier (always 0)

0x00

0x13 Command length

0x01 Unit identifier (adjustable: 1 - 247)

0x10 Function code 16 (multiple write command)

0x00 :

0x20 Start register

0x00 .

0x06 Number of registers

0x0c Number of bytes

0x00 0 "

0x02 Corresponds to "setq

0x00 i

0x00

0x06 .
0x24 scanCONTROL address for user modes (lower 16 bit)
82;8 scanCONTROL address for user modes (upper 16 bit)
0x00 i

0x00

0x[User mode no.]0

0x00 for user mode 0, 0x10 for user mode 1, ..., OxfO for user mode 15

0x00
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4.3.4 Loading of User Modes using 2D/3D Gateway

You may use the 2D/3D Gateway in order to load user modes via ProfiNET, Ethernet/IP or EtherCAT. The

assignment of the Modbus registers 32-37 to the output data on the gateway is a prerequisite.
Please use the following command:

- Load user mode: Write the following output data bytes in order to load a user mode:

Assigned Corr. Value Description

output data Modbus-

bytes Register

10-11 37 O0x[User mode 0x0000 for user mode 0, 0x1000 for user

no.]000 mode 1, ..., 0xf000 for user mode 15

8-9 36 0x0000 -

6-7 35 0xfofo scanCONTROL address for user modes
(upper 16 bit)

4-5 34 0x0624 scanCONTROL address for user modes
(lower 16 bit)

2-3 33 0x0000 -

0-1 32 0x0002 Corresponds to "setq"
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5. Appendix
5.1

Status and Error Messages

Various status and error messages are displayed in the status bar of the software. The following

messages can appear:

Message

Description

Action

Active: scanCONTROL
[Type]([Option])[Version]

X of X sensores are active

1 sensor is active

No error. Measurement is active.

No sensor is active

No error. No sensor is active.

Select a sensor and click the
"Connect" button (see Chapter 3.4).

Internal error

An unknown error has occurred.

Close Result Monitor and reset the
sensor to the default settings by
briefly interrupting the power

supply.

Data transfer interrupted

An error occurred during data
transfer.

scanCONTROL is not connected
to the PC via Ethernet or the

Check the Ethernet connection and
check whether the sensor is
switched on and supplied with

No scanCONTROL found scanCONTROL power supply is | power. Check the Ethernet cable for
switched off. defects. Check the scanCONTROL
network setting (see Chapter 3.18)
No free scanCONTROL égnsqer&?g:zf:g: gggedggi:]heuse d Close the other programs accessing
found b y being scanCONTROL.

by other programs.

scanCONTROL is already
in use

The currently used sensor is
already used by other programs.

Close the other program that is
accessing scanCONTROL or select
a different sensor and click the
"Connect" button (see Chapter 3.4).

Invalid device

The currently operated device is
not a scanCONTROL measuring
system.

Select a different sensor and click
the "Connect" button (see

Chapter 3.4) or close Result
Monitor, connect scanCONTROL to
the PC and restart the software.

Error while data transfer

The data transfer between
scanCONTROL and the PC has
been interrupted.

Check the Ethernet connection
between scanCONTROL and the
PC. Check the Ethernet cable for
defects. Close Result Monitor,
reconnect scanCONTROL to the PC
and restart the software.

Corrupt profile

The transferred profile is corrupt.

Check the configuration of the
connected scanCONTROL (see
Chapter 1.2).
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No points in region of
interest

No valid measuring points are
located in the scanCONTROL
measuring range.

Change the distance to the object
to be measured. Check the
configuration of the connected
scanCONTROL (see Chapter 1.2).

Too much profile data. Loss
of data possible.

The amount of profile data

transferred approaches the
available bandwidth of the

network.

Too much profile data. Data
transfer not possible.

The amount of profile data
transferred exceeds the available
bandwidth of the network.

Check the configuration of the
connected scanCONTROL (see
Chapter 1.2) and reduce the
amount of profile data transferred.
Decisive for this are the number of
connected measuring systems and
the profile points, the profile format
and the profile frequency.

5.2 Notes and Tips on Using scanCONTROL

Please note the following when operating Result Monitor:

1 Never disconnect the connection between scanCONTROL and the PC while the software is
running. Never disconnect the power supply of scanCONTROL while the software is running.
This may cause the software to shut down unintentionally.

2 There may be a discrepancy between the setpoint value and the actual value for the scan rate if the
number of scans is set too high for the processing power of the PC.

3 Select the "? > Online help" menu item or press the <F1> key to access a description of the
dialog that is currently displayed.
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5.3 Key Shortcuts

Use shortcut keys to work faster. The following shortcuts are available:

Key combinations

Action

F1

Open the online help

Ctrl + F1...F4 Save ring buffer sensor 1...4
Ctrl + O Load parameters
Ctrl + S Save parameters
Ctrl + R Reset parameters

Ctrl + Alt + F1...F4

Activate scanCONTROL parameters sensor 1...4

Ctrl +1...4 Activate logging of results sensor 1...4
Ctrl + F7 Adjusting Basic Settings
Ctrl + F8 Adjust scanCONTROL network settings

Note: If some key shortcuts do not work, please check whether these shortcuts are used by other

programs.
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